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Infinite Campus and Custom Computer Specialists, Inc.

About Infinite Campus

Infinite Campus is a comprehensive, Web-based K-12 student information system (SIS)
with real-time access to administration, instruction, communication, curriculum, reporting
and analysis, data warehousing functionality and more. For 25 years, Infinite Campus has
successfully implemented its solutions for customers of all sizes. Managing 7.8 million
students in 45 states, Infinite Campus is the most trusted name in student information.
Infinite Campus customers range from school districts with fewer than 100 students to
those with more than 600,000, as well as regional consortia, state departments of education
and the federal government.

About Custom Computer Specialists, Inc.

Headquartered in Hauppauge, N, Custom Computer Specialists, Inc., is a leading
privately held Long Island based technology solution provider. Custom delivers a wide
array of technology services including: project management, on-site staffing, managed
services, networking and wireless solutions, desktop installation, and service and support.
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GRADING AND REPORT CARD SET UP

Description

Grading students can be completed using Infinite Campus by putting in grades or by
having the system calculate the grades when using the Grade Book and Assignment tools.
If the Grade Book and Assignment tools are utilized, the teacher will create Categories
(i.e., Tests, Homework, and Quizzes) and Assignments within the Categories (i.e.,
American Revolution test, WWI test, and WWII test). The grades are entered into the
Grade Book and the system will calculate the marking period grades.

Target Audience
This manual is intended for District and School administrators who determine the grading
requirements for courses.

Obijective
The purpose of this manual is to assist administrators in understanding the different
components that will be used in grading and the reporting of grades in Campus.

Vocabulary

Grading Scales — This is used by the system if the Assignments & Grade Book tools are
utilized. The grading scale determines the scores that can be entered (i.e., 99, 85, 63, A+,
A, B), the values of those scores and what score will be posted to the student if the
calculation results in a score that is not used by the district (i.e., 89.7 will post as 90, 76.2
will post as 76, 86 will post as B+). The Grading Scales are usually set up at the District
Level, but a district can assign teachers rights to set up unique ones.

Score Group — The Score Group is used to house GPA values for each score. It can be
used to calculate the Final Grade as well. The score group also determines if the score
will post credit(s) on the transcript or not. The Score Group should MATCH the Grading
Scale. The Score Group is set up at the District Level.

Grading Comments — This is a list of pre-determined comments that can be added to the
report card. They are set up at the School Level.

Grading Tasks — The Grading Tasks are used by Campus to create a ‘field’ that will
receive a grade to print on the report card or progress report (i.e., Quarter Grade, Final
Grade, Final Exam). They are also used to determine if a grade will post to the transcript.
They are set up at the District Level.

Term GPA — Used on Marking Period Tasks — the weight of the score toward the GPA
(usually 1, but can be more or less if it needs to be weighted differently).

Grading © 2017 Custom Computer Specialists, Inc. All Rights Reserved 1
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Vocabulary continued

Grade Calc Options/Composite Grading — A District can choose to use the Composite
Grading feature that will calculate the Final Grade (or Semester Averages) based on
Grading Tasks chosen and their % value (i.e., Q1 Grade — 23%, Q2 Grade — 23%, Q3
Grade — 23%, Q4 — Grade 23%, Final Exam — 8%). A teacher can create a different
composite grading calculation if they use the Grade Book and the District grants
permission.

Term Mask — Grading tasks must be designated for the term where they will be used
(i.e., Quarter Grade will have all 4 Terms checked; Final Exam [in a full year course]
will have just Term 4 checked).

Active Mask — Grading Tasks must be ‘activated’ in order for the teachers to post grades.
Usually they will be activated for a short time, and then deactivated. This will prevent the
teachers from changing the grades after the report cards have been printed.

2 © 2017 Custom Computer Specialists, Inc. All Rights Reserved Grading
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SET UP GRADING SCALES

Description

A Grading Scale is used to convert a student’s in-progress Grade Book calculation (%) to
a score (Grade) for a grading task/standard (e.g., Q1 Quarter Grade). The Grading
Scale can be set up as Alpha, Numeric, Rubric, or Pass/Fail. For example, an in-progress
calculation 87.63 might convert to 88 on a numeric scale or B+ on an alpha scale. Many
districts set up the Grading Scale on a school or district level and do not allow teachers to
create their own. If a district decides not to utilize the Infinite Campus Grade Book, then
grading scales are not a factor in grading.

1. Navigate to System Administration > Grading & Standards > Grading Scales.
2. Click on the <New> button.

3. Type the Name of the Grading Scale. It is recommended to use names that define
the type of grades being calculated (i.e., Alpha, HS Numeric, MS Numeric, etc.).

4. Type the Name of the first score — it is usually named the same as the actual score
(i.e., 100’ for score 100, ‘B’ for score B).

5. Type the Score (grade received). The Grading Scale score must match a score in
the school’s score group. For example, a user should not create an ‘A+’ if the
district hasn’t set up an ‘A+’ score to print on the report card.

6. Type the Min Percent. This is the minimum percent calculated that will post the
score (grade) to the student. For example:

a. 100 —99.5 (student has at least a 99.5 to receive the 100 score)
b. 99 - 98.5 (the student has between 98.5-99.4 to receive the 99 score)
c. A —90 (student has at least a 90 to receive the A score)
d. B —80 (student has between 80-89 to receive the B score)
These must be entered in order from highest score to lowest.

7. Type the Sequence number. All grades should be sequenced so they display in
order, with the highest grade first.

8. Check the Passing checkbox for all scores that are considered passing scores.
This will highlight the non-passing grades in the Grade Book.

9. Click on the <Add Grading Scale Item> button to add another grading scale item.
10. Click on the <Save> button.

Grading Scales © 2017 Custom Computer Specialists, Inc. All Rights Reserved 3



Right People. Right Results.®

@ Custom Computer Specialists

.,

Infinite ("
Campus

Example of Numeric Grading Scale

Grading Scales

Save

Grading Scale Editor

.:-". Delete

Name
Numeric -
Numeric 10 +6%
Numeric 100 +6%
Rubric ¥
Grading Scale Detail
*Name
{F\Iumeric I
Grading Scale ltems Detail

Name Score Min Percent Sequence Passing
X 100 1100 foos 1 | @
X lo9 |99 oes 2 | @
x |og |los llo7.5 3 | @
* o7 |lo7 965 1[4 | @
x |96 |96 955 |5 | @
X los_ los Jloas __J6 | @
X o4 Jloa llo3s 7 | @

Example of Alpha Grading Scale

Grading Scales

Alpha Grades
ESNU

HS Grade Scale
Manual Rubric

Grading Scale Detail

*Name
Wha Grades ]
Grading Scale ltems Detail

Name Score Min Percent Sequence Passing
x A+ A |[o5.5 ] @
X [» 13 s || @
X A A 875 B_| @
X e- e less |+ | @
X B B |[815 6| @
X B | B- 1775 s | @

If a grading scale needs to be removed, click on the grading scale Name and select the
<delete> button. It will be deleted when the changes are saved.

&5 Special Note:

Grading scales should not contain exception marks such as late, incompleate or

missing. Only include calculated grade values.

© 2017 Custom Computer Specialists, Inc. All Rights Reserved
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SET UP SCORE GROUPS

Description

The Score Group is used to create a list of possible GPA values that can be posted for the
grades. It is also used to calculate the Final Grade if Composite Grading is utilized. The
Score Group should MATCH the Grading Scale (if set up). Score Groups can be set up as
Alpha, Numeric, Pass/Fail, or Rubric (to be used for Standards Based Grading). The
score group also determines if the score will post credit(s) on the transcript or not. The
Score Group is set up at a District Level.

1. Navigate to: Grading & Standards > Score Groups & Rubrics.

2. Click on the <New Score Group> button. To set up Rubric Score Groups, refer to
the Standards Based Report Card Manual.

3. Type the Name of the Score Group. It is recommended to use names that define
the type of grades being calculated (i.e., Alpha, HS Numeric, MS Numeric, etc.).

4. Type the Sequence number. All grades must be sequenced so they display in
order with the highest grade first.

5. Type the Name of the first score — it is usually named the same as the score (i.e.,
100’ for score 100, ‘B’ for score B). This is the name the teachers see when
grading.

6. Type the Score (grade received). This is the score that will show on the student’s
Grades tab, Report Card, and Transcript.

7. Check the Passing checkbox for all scores that are considered passing scores. At
least one grade must be checked before saving. However, it is recommended to
only check one box, save, then check the lowest passing grade — the system will
automatically check all the grades listed above that grade.

8. Type the Credit Coeff. This number will multiply by the credits attached to the
course to post credits to the Transcript. If this is determined to be a ‘passing’
grade, the Credit Coeff should be 1°. Ifiitis a ‘failing’ grade, the Credit Coeff
should be ‘0’.

9. If needed, type the Min Percent. This is used for Composite Grading. This
number is the minimum percent calculated that will post the grade to the student’s
Final Grade (or Semester Average).

10. Type the GPA Value. This is the Weighted GPA score that will be used in the
GPA calculations (both Term and Cumulative). For a non-weighted score group,
this is usually the same as the Score for a Numerical grade, but for Alpha grades,
it is the value used to calculate the GPA (i.e., 4.0, 3.75). Also, some districts use
this to create a weighted grade for Honors or AP courses (i.e., a ‘90’ might have a
value of ’93” in this field). If entering a ‘non-grade’ (i.e., Pass, Fail, Incomplete),
it is recommended to leave this field blank so it is not included in GPA
calculations.

Score GrOUpS Set Up © 2017 Custom Computer Specialists, Inc. All Rights Reserved 5
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Unweighted GPA. — Enter the unweighted GPA value. If the GPA Value is being
used to create a weighted grade (usually for Honors or AP courses), enter the
unweighted GPA value here (i.e., using the example in step 8, a ‘90’ will have a
value of ‘90’ in this field). It is recommended to enter the unweighted value in
this field regardless of whether this score group is creating a ‘weighted” GPA
since this GPA can be used to calculate an Unweighted Cumulative GPA, if
needed. This GPA cannot be used to calculate the Term GPA. If entering a
‘non-grade’ (i.e., Pass, Fail, Incomplete), it is recommended to leave this field
blank so it is not included in GPA calculations.

Type the Bonus Points the student receives for achieving the score. If bonus
points are not used, leave this field blank. If bonus points are to be used, the field
must be checked on the Course tab and in the Allow GPA Bonus Points field in
System Administration > Preferences > System Preferences. Bonus points will
add directly to the calculated GPA average (both Term and Cumulative).
For example, the student received a ‘90’ in a course, and the Term GPA is 89.52.
If the ‘90’ in the Score Group had Bonus Points of ‘3°, the student’s Term GPA
will be 92.52.

Bypass Composite -Checkbox appears if option to require all grades for
composite grading is selected in System Admin>Preferences>System Preferences.

& Special Note:
Options to turn on or off GPA Value, Unweighted GPA and Bonus Points on report
cards and transcripts determine how these are set up.

1. GPA Value - On report cards the GPA Value will always be used to calculate

Term GPA. On transcripts, there is the option to use GPA Value or Unweighted
GPA for the Cumulative GPA (as well as for class rank and percentile).

Unweighted GPA — On report cards, the Unweighted GPA Value will not be
used to calculate the Term GPA. On transcripts, there is the option to use GPA
Value or Unweighted GPA for the Cumulative GPA (as well as for class rank
and percentile).

Bonus Points — On report cards, there is a choice to include Bonus Points in
both the Term GPA as well as the Cumulative GPA. On transcripts, there is the
option to include Bonus points with either (or both) GPA Value or Unweighted
GPA for the Cumulative GPA calculation (as well as for class rank and
percentile).

© 2017 Custom Computer Specialists, Inc. All Rights Reserved ~ SCOI€ GrOUpS Set Up
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& Special Note continued:

Many districts print weighted and unweighted Cumulative GPAs on the transcript.
Since the report card only uses the GPA Value, if the Term GPA needs to be
unweighted, but the Transcript needs to display the weighted GPA, the following is
recommended:

1. Create a Score Group for the Unweighted GPA (including the same value in
both the GPA Value and Unweighted GPA Value fields).

2. Create a Score Group for the Weighted GPA (including the unweighted
values).

3. Apply the Unweighted Score Group to the Marking Period Grading Task
(i.e., Quarter Grade) (refer to Course Information and Grading Tasks, page
16).

4. Apply the Weighted GPA to the Final Grading Task (refer to Course
Information and Grading Tasks, page 15).

The Unweighted Score Group will also be applied to the Marking Period and Final
Grading Tasks for all courses that are unweighted (i.e., all courses that are not
‘Honors’ or ‘AP’).

14. Click on the <Add> button to add another score item.
15. Click on the <Save> button.

Score GFOUpS Set Up © 2017 Custom Computer Specialists, Inc. All Rights Reserved 7
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If a score in a group needs to be removed, click on the delete button (x) to the left of the
score Name, and it will be deleted when the changes are saved.

Example of Numeric Score Group without Weighted GPA or Bonus Points

Score Groups & Rubrics

n Save Delete E New Score Group B New Rubric
[

youp Dets

'Na;né

Numeric

Score Group List items Detail

Credit Minimum GPA  GPA GPA
Sequence Name Score  Passing Coefl. % Value  Unweighted Bonus  Class Detail Outcome
Score Value Points  Code

X 1 | [100 |10 | [t |oes | [1o0  ff1oo | o Il v
X 2| Jeo lloo |6 [+ Jloes |lo9 flm | o |l .
bt B__| |o8 s |i@ [t Jozs [fes  Jfss [ o || ¥
X 4| o7 flor__ 6@ [1 Jlees Jlor Jlov [ o |l :
X 5| Jos | [t [less |lee  [ee | o |l X
X 6] [es flos 6@ [t Jloas Jles s [ fo |l %
| Add |

Example of Numeric Score Group with Bonus Points

Score Groups & Rubrics

n Save Delete ﬂ New Score Group B New Rubric
|

core Group Detai

"Name
Numeric with Bonus
Score Group List items Detail
Credit Minimum GPA  GPA GPA
Sequence Name Score  Passing Coeff. % Value Unweighted Bonus  Class Detail Outcome
Score Value Points  Code
X 1| 100 [ltoo | @ |1 Jlees | [to0 {100 | Joo2 || v
X 2| l» oo @ 11 Jloss [le9 [fes | ooz |l Y
x N s | [t Jlo7s Jfes s | ooz | Y
x [a ] o7 llor | [t Jloes [foz  Jloz | fo02 || v
| Add |

8 © 2017 Custom Computer Specialists, Inc. All Rights Reserved ~ SCOIe GfOUpS Set Up
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Example of Numeric Score Group with Weighted & Unweighted GPA

Score Groups & Rubrics

n Save Delete a New Score Group B New Rubric
L

Score Group Detail
"Name
]Numeric AP/Honors I

Score Group List items Detail

Credit Minimum GPA  GPA GPA
Sequence Name Score Z::g\g(‘,oeﬂ % Value Unweq\tedBoms mDe‘laIOuwome

x i oo [ J@ [ Jeos | [0 Jwo | (_il ;
X 2| |oo floo |@ |1 Jleas |[1w089 [lee | fo i
x 5 | [ N E Cmomm :
X 4 | [o7 oz 1@ [1 965 | [1067 |lo7 | o Il v
x 5| e s @ [1_Joss |fwse Jss || :
X 6| los llos 1@ |1 |foas | [10a5 s | o i v

e

Example of Alpha Score Group with Weighted & Unweighted GPA

Score Groups & Rubrics

= Save Delete E New Score Group B New Rubric

Sequence Name Score  Passing Coeff. % Value Unweogtmu ﬂus Class Detail Outcome
Score Points  Code
x P | a1 Jless s |45 [ oIl x
X 2| la__l& 1 Jis15 |as s I |l ¥
x B I | (1 Jlezs a2 Jisz [ o |l ¥
X 4| [p+ flB+ @ [t lless |39 34 o |l ¥

Score GI"OUpS Set Up © 2017 Custom Computer Specialists, Inc. All Rights Reserved 9
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SET UP THE CREDIT GROUP

Description

Credit groups are created with sub-groups under them (i.e., Group = High School Credit,
Sub-Group = English). Each course will have a ‘sub-group’ assigned to it. Any student
who passes the course will receive the course credit for the class (assigned on the grading
task). Credit groups need to be set up and applied to courses in order for the course to
post to the transcript.

Courses can only be assigned to ONE Credit Group.

&S Special Note:
Since courses can be in only one Credit Group, it is recommended to create a
single Credit Group (barring special circumstances).

1. Choose the school using the Credit Group in the header toolbar. If multiple
schools are using the group (i.e., 2 HS, HS and MS), choose one here and activate
the Credit Group on the others (refer to Activate the Credit Group’ on page 12).

Navigate to: Grading & Standards > Credit Groups.
Click on the <New Group> button.
Type in the credit group Name.

o > N

Credit Overflow Rollup — This section indicates where the student receives credit
when the student has met the credit requirement of the designated credit type and
where the additional credit should now be placed. This field only applies to credit
types and should be left blank for credit groups.

6. Click on the <Save> button.

Lredit Group Det:
‘Mame

HS Credit

PESC Name

Parent Group
v

Credit Overflow Rollup

b4

Comments

7. To add the Credit Type, click on the <New Group> button.
8. Type in the Credit Type Name (i.e., English, Mathematics, Social Studies).

10 © 2017 Custom Computer Specialists, Inc. All Rights Reserved Credit GfOUpS
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9. Credit Overflow Rollup — This section indicates where the student receives credit
when the student has met the credit requirement of the designated credit type and

where the additional credit should now be placed.

10. Choose the Parent Group from the list (the Credit Group created in steps 3-6).

11. Choose a PESC Name if the district is using the eTranscript module. Options for
this drop list are available when a Parent Group is selected (step 10).

12. Click on the <Save> button.

redit Group Def
"Name
History
PESC Name

Parent Group
HS Credit v |
Credit Overflow Rollup
Electives ¥
Comments

13. Repeat steps 7-12 for all sub-groups needed.

Credit Groups
New Group

Credit

- [_1 HS Credit N
CaAr
(] Electives
(1 English
] Fine Arts
(1 Foreign Language >' «—
(1 Mathematics
1 Music
(Z1 Physical Education
(Z1 science
(Z1 Social Studies
- MS Credit
CaArt

14. Repeat steps 1-13 for all Credit Types needed.

Credit Groups

© 2017 Custom Computer Specialists, Inc. All Rights Reserved

The Credit Group
or Parent group.

The Credit Types or
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Activate the Credit Group

The Credit group will be automatically activated for the school that was in the header
toolbar when it was created. If the Credit groups are to be used in additional schools (i.e.,
additional High Schools, High School credits used in the Middle School), they must be
activated in order to be attached to a course. Multiple credit groups can be activated for a
school if necessary. All the Credit Groups set up for the district will display (in addition
to the any School Standards that were created).

1.

12

Choose the School and Year to activate the Credit Group.
Navigate to: System Administration > Resources > Resources.

2
3. Click on the School Standards tab.
4,

5. Click on the <Save> button.

Click on the check box for Credit Group(s) needed to place a check in it.

Rydell High School
School Mumber: 82  Principal: Robert Ridarell

Departments Rooms School Standards
Save
Curriculum Standards
HS Credit
|:| MS Credit

© 2017 Custom Computer Specialists, Inc. All Rights Reserved Credit GfOUpS
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SET UP GRADING COMMENTS

Description
Grading comments can be set up at the District and School Level and used by all teachers.
They are used to keep comments consistent throughout the school.

1.

o~ w

Navigate to: System Administration > Grading & Standards > Grading
Comments.

Select the All schools (for District Wide) or specific school on the top toolbar.
Click on the <New> button.
Type the Comment — maximum of 200 characters.

Code — type in the code if used by the district. The Code allows the teacher to
choose comments by typing in the codes needed instead of choosing from a list.

Click on the <Save> button.

Once saved, the comments will display in the top section in alphabetical order or
numerically if numeric codes are used. Repeat for all comments needed.

Grading Comments

New

Grading Comment Editor

School | Name | Code

Campus High School A pleasure to have your child in class.

Campus High School Assignments not completed satisfactory. .

Campus High School Average to date 65-69 \ Periods can

Campus High School Average to date 70-79 / be added to

Campus High School Average to date 80-89 end of

Campus High School Average to date 90-100 Comment

Campus High School Excessive absence. Name or not.
&< Special Note:

These comments can be ‘spell checked’ by pressing <Ctrl>-<Shift>-<L>.

Many districts structure comments to display ordered by type (i.e., positive,
negative, improvement, effort, behavior, etc.). This can be achieved by coding.
Many teachers will choose more than one comment to display on the report card. If
periods are not included in the comment, the system will automatically add them
when applied to a student (in order for them to be separated on the report card). If
periods are included, the system will recognize them and not add an additional
period. Therefore, all comments in the picture on the previous page will work
correctly.

If the district is using a custom report card, there will be a character limit on the
comments entered on individual students based on the size of the field. If the
district is using a Campus report card, there is a 1200 character limit on the
comments.

Grading Comments © 2017 Custom Computer Specialists, Inc. All Rights Reserved 13
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SET UP GRADING TASKS

Description

The Grading Tasks are used by Campus to create a ‘record’ that will receive a grade to
print on the Report card, Progress report, or Transcript (i.e., Quarter Grade, Final Grade,
Final Exam, Progress Report). These are set up at the District Level.

1.
2.
3.

Navigate to: Grading & Standards > Grading Tasks.
Click on the <New> button.

Type the Name of the Grading Task (i.e., Quarter Grade, Final Grade, Progress
Report).

Type in the Number if necessary.

5. The Seq number can be used to order the Grading Tasks here and on report cards.

Type in the Code if necessary. This is a pre-defined code by the State or district if
required.

If the grade is being posted to the transcript (i.e., Final Grade), click on the Posts
to Transcript box.

State Reported — this field can be used to create Ad Hoc reports to filter scores for
these grading tasks.

If the district wants the Grading Tasks to be nested, they can accomplish this by
using the Parent Grading Task.

10. Click on the <Save> button. Repeat steps 1-9 for all Grading Tasks needed.

14

Grading Task Detail

*MName

|Final Exam ®

MNumber Seq Code Posts to Tranzscript

| | o | | | O

State Reported External LMS Exclude
L] L]

Parent Grading Task

| W

Comments

Grading Tasks
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COURSE INFORMATION AND GRADING TASKS

Description

There are several fields on the course tab that affect grading (i.e., GPA Weight,
Transcript). In addition, the Grading Tasks are added to the Grading Tasks tab in the
course information.

Course Tab
1. Navigate to: Scheduling > Courses. Choose the course.

2. On the Course tab, fill in the following fields needed for report cards and
transcripts:

a. GPA Weight — type ‘1’ for normal GPA weight. If a different weight is
used, it will affect the GPA on the transcript (for example, a weight of 3
will weight the score of this course more when calculating the Cumulative
GPA on the transcript). For more information on weighing GPAs, refer to
next section on page 20.

b. Bonus Points — click on the checkbox if bonus points are being utilized for

this course.
c. Transcript — click on the checkbox if the final grade is to post to the
transcript.
0100 English for All
Course Sections Grading Tasks Standards Categories Grade Calc Opiions Course Rules

Save Delete
CourselD 9254
*Mumber *Name Standards-based Active Exiernal LMS Exclude
[English for Al | ] O

Subject Type

v]

State Code Department

English w
Schedule Load Priority Max Students Terms  Schedules Pericds  Secfions to Build

b 2 | [ ] [e

Secfion Template Group
~
GPA Weight Bonus Points Transcript Required
] v ]
Dwal/Concurrent Credit
| v] 1
.
| v]

Homerocom Allow student requests Allow teacher requestsirecommendations Repeatable Aftendance Positive Attendance
[ ] [ [ v L

Course Information © 2017 Custom Computer Specialists, Inc. All Rights Reserved 15
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Add the Grading Tasks to Courses

16

1. Onthe Grading Tasks tab, create the grading tasks needed for the report card and

transcript.
a. Click on the <Add> button.

Example of New (blank) Grading Task to Add to a Course

Courze Grading Task Detail

*Grading Task
| vl
*Score Group
| v
Term GPA Credit Credit Type
W
Credit Overflow Override
Term Mask Vi Term 1 M Term2 Wl Tem 3 [V Tem 4
Active Mask [ltem1 [lTerm2 [lTerm3 [l Term 4
[ Post-only Grading Task

b. Choose the Grading Task from the list. If the Grading Tasks were entered
with sequence numbers, they will display on the list in that order.

Choose the Score Group from the list.

d. If the task needs to be included in the Term GPA, type ‘1’ for normal GPA
weight. If a different weight is used, it will affect the GPA on the report
card (for example, a weight of .5 will weigh the score of this course less
when calculating the Term GPA on the report card). Usually Marking
Period Grades (i.e., Quarter Grade, Marking Period Grade, Trimester
Grade) have Term GPAs. For more information on weighting Term
GPAs, refer to the next section on page 19.

e. If the task will post credits to the student’s transcript, enter the amount of
credits in the Credit field (i.e., ‘1’ for a full year course, .5’ for a half year
course).

f. Choose the Credit Type (this determines which Credit Group the credit
will post to). Usually Final Grades will have Credits and Credit Types. If
a course will have credits posted to the transcript, a Credit Type must be
set up (Grading & Standards > Credit Groups — for more detailed
information, refer to page 10).

g. Choose the Credit Overflow Override — this field is used to roll credits
when the current credit type has met its credit requirements. The credits
from the course will first try to roll up to the override credit type. If that
credit type has met its requirements, it will then look at the overflow setup
for the course's credit type.

h. Check each term the grading task will be used for in the Term Mask
section. For example: Marking Period Grades have all terms checked off

© 2017 Custom Computer Specialists, Inc. All Rights Reserved Course Information
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and Final Grades have Term 4 checked off (or Terms 2 & 4 for half year

courses).

i. Check the term to activate the grading task in the Active Mask section.
When the term is active, the teachers can post the grades for that task.
Although the Grading Task can be activated (or deactivated) on each
course individually by checking the box here, the Active Masks are
usually controlled en-masse by using the wizard in Grading & Standards
> Grading Window module.

j. Click on the <Save> button.

k. Repeat for all Grading Tasks needed (i.e., Quarter Grade, Final Grade,
Final Exam, Progress Report, State Exam). The Task must be entered on
the course for it to print on the Report Card (or Transcript).

Choose the
score group Example of a Marking Period Grade
for the o
grading task *Grading Task
Quarter Grade v
*Score Group
A-F plus/minus no round v
Enter the Term GPA Credit Credit Type
. 5 - 1 v
‘Welght if the Credit Overflow Override
grading task is I ¥
to be used in the ey ¢ Term1 ¥/ Term2 ¥/ Term 3 ¥/ Term 4 1—\
Term GPA Term 1 Term 2 Term 3 Term 4 -
calculation -only Grading Task
Indicates a grading task cannot be aligned to assignments
and categories in the teacher's Grade Book. Post-only
Grading Tasks are for posting grades only, not for aligning
Choose the student work.
:g?;ﬁgroup Example of a Final Grade
grading o
*Grading Tas!
task ™| _Final Grade
*Score Group
A-F plus/minus no round v
Term GPA Credit Credit Type
1 English/Language Arts v
Credit Overflow Override
Elective v
z : 2 Term1 | ' Term2 | Term3 ¥/ Term 4 \
Type the Active Mask Term 1 Term2 | ' Term3 | Term 4

Check on all the
terms where the
grading task will be
used (for a quarter
grade, it will usually
be all 4 quarters)

Choose the credit
type to post on the
transcript

Check on all the
terms where the

credit amount Post-only Grading Task

to post on the
transcript
(usually “1°
for a full year
course)

Course Information

© 2017 Custom Computer Specialists, Inc. All Rights Reserved

grading task will be
used (for a final
grade, it will usually
be only Term 4, or
Terms 2 & 4 for a
‘semester’ course)
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Example of a Progress Report Grade

Course Grading Task Detail

v |

Check on all the
terms where the
grading task will be
used (for a progress
report, it will usually
be all 4 quarters)

Grading Task
Progress Grade
*Score Group
Choose the Y ’Tpmgg:/: 'C“ed Credit T
g :
score group for ﬁ""— ----- i [-"* — [—
the grading task Credit Overflow
L v]
U bl ¥ Term1 ¥/ Term2 ¢/ Term 3 ¥ Term 4
Active Mask ¥ Term1 [/ Term2 |/ Term3 | Term 4
|| Post-only Grading Task
Example of a Completed Grading Task Editor
Course Seclions Grading Tasks Standards Categories Grade Calc Options

O« B

Grading Task Editor
| Grading Task

| Credit Type

Course Rules

| Score Group

Fees

| Credit | Term GPA | Post-only

Build Constraints

D Final Exam

D Final Grade

D Progress Report
D Quarter Grade

HS Credit English

Numeric
Numeric

Prog Rpt

Numeric

1.000

1.000

18
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GPA WEIGHTS

Description

The Term GPA and the Transcript (Cumulative) GPA can be weighted for a course to
count the grade as more or less than the other courses. This is typically used to weigh
courses based on instruction length. For example, the grade for a course meeting 3
periods might count more than a class meeting for only 1 period. Conversely, the grade
for a course meeting on the ‘A’ rotation all year might count less than a course meeting
both days. This is not generally used for Honors or AP courses as this is a true weight
(please refer to the calculation examples on the next pages). If the student is to receive
a HIGHER score, it is recommended to utilize the GPA Value or Bonus Points
options in the Score Group instead of changing the weight.

Transcript (cumulative) GPA: The GPA that posts to the transcript can be weighted by
entering the weight on the Course screen. The GPA Weight on the course will affect the
students’ GPA on the transcript.

310081 English 9

urse Sections Grading Tasks Standards Categories Grade Calc Options Course Rules Fee

Enter the -
GPA jSave Delete The Transcript
weight B Course Information checkbox must be

CourselD 23215 Course Master Linked h k

*Number *Name Stan: ased chec ed

310051 English 9

Subject Type
v
State Code Department
English v

Schedule Load Priority Max Students Terms Schedules Periods  Sections to Build

L3|] 30 2 1 1 6

GPA Weight Bonus Points Transcript Required

1 4 4

Term GPA: The Term GPA can be weighted by entering the weight in the Grading
Task. The Term GPA weight will affect the students’ Term GPA on their report card or
for Honor Roll.

ourse Grading : Det:
Grading Task
Enter the Quarter Grade
Term GPA *Score Group
weight “a A-F plus/minus no round v ) )
Term GPA Credit Credit Type
1 v
Credit Overflow Override
v
Toum Meck ¥ Term1 ¢/ Term2 ¥/ Term 3 ¥/ Term 4
Active Mask Y Term1 | ' Term2 | /Term3 || Term 4
Post-only Grading Task

GPA Weights © 2017 Custom Computer Specialists, Inc. All Rights Reserved 19
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GPA Calculation (posts to transcript):

The system calculates the transcript GPA by multiplying the GPA value of each course’s
final grade (from the Score Group) by the GPA weight on the course and adding the
‘new’ grades together. Then, it adds all the GPA weights together. Finally, it divides the
total ‘grades’ by the total GPA weights. This weighing is most commonly used for full
year (GPA=1) and half year (GPA=.5) classes. It can also be used for Vocational
Tech courses that meet for several periods of a day.

Example using the Cumulative GPA based on course length:

The two students below are taking 4 periods of graded courses. Mary takes 4 classes of 1
period each, Harry takes a 3 period class (i.e., a Vocational Tech class) and a single
period class.

Mary Jones — Final Grades:

Science 90 (GPA weight 1)

Math 90 (GPA weight 1)

Social Studies 90 (GPA weight 1)

English 80 (GPA weight 1)

(90*1)+(90*1)+(90*1)+(80*1) = 875
1+1+1+1

Harry Smith — Final Grades:
Auto Repair 90 (GPA weight 3)
English 80 (GPA weight 1)

(90*3)+(80*1) = 875
3+1

Example if Cumulative GPA courses are NOT weighted based on course length:
Mary Jones — Final Grades:

Science 90 (GPA weight 1)

Math 90 (GPA weight 1)

Social Studies 90 (GPA weight 1)

English 80 (GPA weight 1)

(0*1)+(90*1)+(90*1)+(80*1) = 875
1+1+1+1

Harry Smith — Final Grades:
Auto Repair 90 (GPA weight 1)
English 80 (GPA weight 1)

(0*1)+(80*1) = 85
1+1

Harry’s Auto Repair should be weighted more since it should be % of the GPA.
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The GPA weight is usually NOT used to weight for Honors or AP classes. Below is
the example of the results if the district attempted to give ‘extra credit’ using the
GPA weight.

Example using the GPA weight for the Cumulative GPA for Honors course:

The two students below are taking regular Science, Math, and Social Studies courses, and
an Honors English course. The regular courses have GPA weights of 1 and the Honors
English course has a GPA weight of 1.2.

Mary Jones — Final Grades:

Science 85
Math 87
Social Studies 82
English H 93

(85*1)+(87*1)+(82*1)+(93*1.2) = 87.05
1+1+1+12

Harry Smith — Final Grades:

Science 85
Math 87
Social Studies 93
English H 82

(85*1)+(87*1)+(93*1)+(82*1.2) = 86.52
1+1+1+12

Since the students received the same grades (85, 87, 82 and 93), the unweighted GPA
would be the same (86.75) for both. However, since the English Honors grade counted
more toward the calculation, Mary Jones’ GPA is higher than the unweighted GPA, and
Harry Smith’s GPA is less.
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Term GPA Calculation:

The system calculates the Term GPA by multiplying each course’s marking period grade
by the Term GPA weight and adding the ‘new’ grades together. Then, it adds all the
Term GPA weights together. Finally, it divides the total ‘grades’ by the total Term GPA
weights. This weighing is most commonly used for Vocational Tech courses that
meet for several periods of a day. It can also be used to weigh ‘every day’ (GPA=1)
and ‘only one rotating day’ (GPA=.5) classes. For example: should a course that
meets on only one rotating day (only day ‘A’) have the same weight as a course that
meets every day?

Example using the Term GPA based on course length:

The two students below are taking 4 periods of graded courses. Mary takes 4 classes of 1
period each, Harry takes a 3 period class (i.e., a Vocational Tech class) and a 1 period
class.

Mary Jones — Quarter Grades:

Science 90 (GPA weight 1)

Math 90 (GPA weight 1)

Social Studies 90 (GPA weight 1)

English 80 (GPA weight 1)

(90*1)+(90*1)+(90*1)+(80*1) = 875
1+1+1+1

Harry Smith — Quarter Grades:
Auto Repair 90 (GPA weight 3)
English 80 (GPA weight 1)

(90*3)+(80*1) = 875
3+1

Example if Term GPA courses are NOT weighted based on course length:
Mary Jones — Quarter Grades:

Science 90 (GPA weight 1)
Math 90 (GPA weight 1)
Social Studies 90 (GPA weight 1)
English 80 (GPA weight 1)

(90*1)+(90*1)+(90*1)+(80*1) = 875
1+1+1+1

Harry Smith — Quarter Grades:
Auto Repair 90 (GPA weight 1)
English 80 (GPA weight 1)

(90*1)+(80*1) = 85
1+1

Harry’s Auto Repair should be weighted more since it should be % of the GPA.
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The GPA weight is usually NOT used to weight for Honors or AP classes. Below is
the example of the results if the district attempted to give ‘extra credit’ using the
GPA weight.

Example using the Term GPA for Honors course:

The two students below are taking regular Science, Math, and Social Studies classes, and
an Honors English class. The regular courses have Term GPAs of 1 and the Honors
English course has a Term GPA of 1.1.

Mary Jones — Quarter Grades:

Science 85
Math 87
Social Studies 72
English H 99

B85*1)+(B87*1)+(72*1)+(99*1.1) = 86.07
1+1+1+11

Harry Smith — Quarter Grades:

Science 85
Math 87
Social Studies 99
English H 72

85*1)+(87*1)+(99*1)+(72*1.1) = 8541
1+1+1+11

Since the students received the same grades (85, 87, 72 and 99), the unweighted GPA
would be the same (85.75) for both. However, since the English Honors grade counted
more toward the calculation, Mary Jones’ Term GPA is higher than the unweighted GPA,
and Harry Smith’s Term GPA weight is less.

GPA Weights © 2017 Custom Computer Specialists, Inc. All Rights Reserved 23
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Changing the weights:

e The Term GPA weights can be changed and the system will automatically
recalculate using the new weights. The Report Card will reflect the new Term GPA
based on the adjusted weights.

e The Transcript GPA can be adjusted, but it will only affect grades to be posted in the
future. Once the grades for each course have been posted to the transcript, they
cannot be re-posted to reflect a change. Re-posting to transcript will result in
duplicate entries for any records that were changed.

If the weights change, they will have to be manually adjusted for each student in the
Student Information > General, Transcript tab or Student Information > Counseling
> General, Transcript tab.

1. Navigate to the Student Information > General, Transcript tab.

Courses Taken 2017-2018 Grade 10

Course Standard Repeat Course Mark GPA Value Bonus GPA Wi. Credit/Category. Term Comments
Transcript igited unweighted
before 2660, Contemporary World | B-  4.0000 3.0000 1.0000 | 1.000 High School Credit 1-2
changes. A-  3.6700 3.6700 1.0000  1.000 English/Language Aris
Harrison High Transcript Addams, Wendy
Tel: (987)999-9876 Fax: (987)888-8889 Student Number: 171900005 Grade: 11
585 Peachtree Parkway, Metro City, NY 55436 666 Mockingbird Lane , Any City, NY 77777
Generated on 01/08/2019 01:05:56 PM  Page 1 of 1
Enroliment History Transcript Statistics Student #: 171900005
Start End Grade School Cumulative GPA (Weighted) 3.78 Current Grade: 11
09/01/2016 10 Harrison High Class Rank 10f2 Birthdate: 06/06/2006
07/03/2017 10 Harrison High Percentile 50.00% Gender: F
07/03/2018 11 Harrison High
Courses Taken 2016-2017 Grade 09 CouyrSes Taken 2016-2017 Grade 10
from 190 Harrison High 190 Harrison High
Course Mark Weight Credit Mark Weight Credit
1100 Integrated Math | A 1.0000 1.000 2630 Non-Western Cultures  A- 1.0000 1.000
2200 World History A B+ 1.0000 1.000 Total Credits: 1.000
3100 English 9 A- 1.0000 1.000
4700 Earth Science A+ 1.0000 1.000
4700 Earth Science A+ 1.0000 1.000
5110 Spanish | A 1.0000 1.000
6500 Concert Band A A- 1.0000 1.000
7100 Physical Education 9 A- 1.0000 0.500

Total Credits: 7.500

Courses Taken 2017-2018 Gradg10

from 190 Harrison High

Course Mark Weight Credit
2660 Contemporary World B- 1.0000 1.000
Issues

3200 English 10 A- 1.0000 1.000

2. Click on the <Edit> button for the course to be corrected.
3. Inthe GPA Weight field, enter the correct GPA weight.
4. Click on the <Save> bhutton.
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Transcript Course Editor
*School Year Grade NCES Grade District No. School No. School Name
|2017-2018 ¥ | [10 v | |10: Grade 10 v | [100 | [190 | |Harison High
*Course Number Course Name State Code
‘ 2660 ‘ Q } Contemporary World Issues ‘ ‘ ‘
SCED Subject Area SCED Course Identifier
Date Actual Term Start Term End Term Change the
loso1s B8 |2 | [1 2 .
‘ =l : ' ‘ 2 __— GPAweight
Terms Long Calendar Terms Term Start Date Term End Date
2 \ 4 | 0710372017 | 1212012017 ‘ =
Current Score Change Score GPA Weight GPA Value Unweighted GPA Value
B . . :
| v .5 | [40000 | [3.0000 |
Repeat Course Distance Eode Percent GPA Max Bonus Points
=] 1 v) |93 | [s.0000 | | \
5. Repeat for each student affected.
Courses Taken 2017-2018 Grade 10
Course Standard Repeat Course Mark GPA Value Bonug GPA Wit [CreditiCategory. Term Comments
weighted unweighted
Edit 2660, Confemporary World Issues B- | 4.0000  3.0000 0.5000 §1.000 High School Credit 1-2
Edit 3200, English 10 A- 3.6700  3.6700 1.0000 §1.000 English/Language Arts
6. Print the transcript again to view the results.
Harrison High Transcript Addams, Wendy

Tel: (987)999-9876 Fax: (987)888-8889
585 Peachtree Parkway, Metro City, NY 55436

Enroliment History Transcript Statistics Student #: 171900005
Start End Grade School Cumulative GPA (Weighted) Current Grade: 11
09/01/2016 10 Harrison High Class Rank Birthdate: 06/06/2006
07/03/12017 10 Harrison High Percentile Gender: F

07/03/2018 1 Harrison High

Student Number: 171900005 Grade: 11
666 Mockingbird Lane , Any City, NY 77777
Generated on 01/08/2019 01:24:19 PM  Page 1 of 1

Courses Taken 2016-2017 Grade 09

Co
from 190 Harrison High fr,

ses Taken 2016-2017 Grade 10
190 Harrison High

Course Mark Weight Credit ourse Mark Weight Credit
1100 Integrated Math | A 1.0000 1.000 2630 Non-Western Cultures  A- 1.0000 1.000
2200 World History A B+ 1.0000 1.000 Total Credits: 1.000
3100 English 9 A- 1.0000 1.000
4700 Earth Science A+ 1.0000 1.000
4700 Earth Science A+ 1.0000 1.000
5110 Spanish | A 1.0000 1.000
6500 Concert Band A A- 1.0000 1.000
7100 Physical Ei ion 9 A- 1.0000 0.500

Total Credits: 7.500

Courses Taken 2017-2018 Grade
from 190 Harrison High

Course Mark Weight Credit
2660 Contemporary World B- 0.5000 1.000
Issues

3200 English 10 A- 1.0000 1.000

GPA Weights
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SET UP GRADE CALC OPTIONS/COMPOSITE GRADING

Description

The Composite Grading feature can be used to calculate the Final grade based on the
marking period grading tasks (i.e., Q1 Grade — 23%, Q2 Grade — 23%, Q3 Grade — 23%,
Q4 — Grade 23%, Final Exam — 8%). It can also be used to calculate a Semester Average
if needed. Composite Grading is set up at the course level, but a teacher can create a
different composite grading calculation for their sections if they use the Grade Book and
they are given rights to the tool.

1. Navigate to: Scheduling > Courses. Choose the course.
2. Navigate to the Grade Calc Options tab.

3. Scroll down and check the Composite box of the Grading Task to be composited.

Grade Calc Options Course Rules Fees Build Constraints Assessments

| Save | | Copy |

Q4 Main Final Grade = 0 Type
[ No Calculation v |
*Child Task/Standard *Weight Effective %
X [Q1 Quarter Grade v| [ 25.0000 25.00
X [ Q2 Quarter Grade v| [25.0000 25.00
X [Q3 Quarter Grade v | [25.0009 25.00
X [Q4 Quarter Grade v | [ 25.0009 25.00

Add

[ ] Lock Section Composites

4. The Composite Grade Detail screen will display with all the Grading Tasks. Type
the weight (%) to be used in the calculation for each task. The total of all weights
generally equal 100. However, if the tasks don’t easily divide into 100,
proportional point values can be used (i.e., 4 Quarter Grades, Midterm Exam and
Final Exam, can all be entered as a weight of ‘1”) — the system will multiply each
task proportionally to calculate the final grade).

*Child Task/Standard *Weight Effective %
X [Q1 Quarter Grade v | [ 25.0000 25.00
X [ Q2 Quarter Grade v | [ 25.0000 25.00
X [ Q3 Quarter Grade v | [ 25.0000 25.00
X [Q4 Quarter Grade v | [ 25.0000 25.00

Add

(| ] Lock Section Composite3

26 © 2017 Custom Computer Specialists, Inc. All Rights Reserved Set Up Grade Calculations
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If needed, click on the Locked checkbox to lock the Composite Grades so they
cannot be changed by teachers and allows pushed changes to overwrite existing
setup in teachers gradebooks.

Scroll up and click on the <Save> button.

Notes on Composite Grading

If a student drops a section of a course and adds a different section of the same
course (i.e., changes teachers or periods for the same course) and the course uses
Composite Grading (on the course level), the grades do not need to be moved to
the new section. The system will use all posted grades for the course, regardless
of the section the student is currently rostered in. Both sections will print on the
report card to indicate which teacher assigned each grade.

However, if a student drops a course after receiving a Grade and adds a different
course (i.e., drops ‘English Honors’, adds ‘English’), the Composite Grade will
only use the grades listed in each course to calculate the Final Grades. This may
have to be manually adjusted. An administrator can adjust the grade by accessing
the Course and Section and navigating to the Grading By Task or Grading By
Student tabs. The Grading Window does not need to be open to adjust the grades
in these tabs — refer to: Editing Grades when Grading Window is Closed section
on page 38.

If a student does not receive a grade for a task, the Composite Grading will use
the grades and weights of the other tasks to calculate the grade. For example:

Q1=21% 920
Q2=21% 95
Q3=21% no grade
Q4=21% 96

Final exam = 16% 88

(90*21)+(95*21)+(96*21)+(88*16)
(21+21+21+16)

7309/79 = 92.52

If the teachers are not given user rights to Composite Grading, there is no need to
‘lock’ it on the Course level.

Set Up Grade Calculations © 2017 Custom Computer Specialists, Inc. All Rights Reserved 27
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SET UP BASIC SECONDARY REPORT CARD

Description
A basic report card consists of Marking Period Grades that post to the term GPA and
Final Grades that post to the transcript. It can include Exams needed as well.

The following must be set up before configuring the courses to print to the report card
and transcript correctly:

e Score Group (see page 5)

e Grading Comments, if needed (see page 13)

e Grading Tasks (see page 14)

e Composite Grading, if needed (see page 26)

Report cards must be created before they can be used. While many districts choose to
have a customized report card created for them, most still need to create a standard report
card using the options provided by Campus so ‘Generic’ report cards can be printed any
time during the year for parent meetings.

1. Navigate to: System Administration > Preferences > Reports.
2. Click on the <New> button.

3. Type in the report Name (i.e., Secondary Card, Q1 Report Card). This is for
internal use and will not display on the Report Card.

4. Choose ‘Report Card’ from the Type dropdown list.

5. Click on the Publish to Portal checkbox if this card should display on the Parent
Portal. Grades will display on the portal as soon as they are posted, so it is
recommended to uncheck this box when the Grading Window is open and
teachers are posting grades.

6. Type in a Description if needed.

*Name *Type Publish to Porial

lGeneric Report Card Q1 , Report Card ¥ v
Description Available in Campus Instruction

7. Available in Campus Instruction- allows a teacher to print a student’s report card
in Campus Instruction.

8. Report Display Name- This field will display on the Report Card.
9. Report Type — Click on the ‘Conventional Report Card’ radio button.

10. Display Grades- allows user to select in-Progress or Posted Grades.
Recommended only select one.

28 © 2017 Custom Computer Specialists, Inc. All Rights Reserved Set Up Basic Report Cards
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11. Report on Terms — Click on the Main- Quarters checkbox and select the Term to
print on the report card. Only one ‘current’ term will print. All previous terms
will print as well, unless the Exclude all prior Terms from printing checkbox is
checked. Click on the Term 4 button to create a Report Card that can be used for
all terms. If only the current term grades should print (and or current term
comments — refer to step 10-e), different report cards should be set up for each
term (i.e., Q1 Secondary Report Card, Q2 Secondary Report Card).

12. Placement and Signature Options-allows multiple options to create signature
lines.

13. Page Layout — Click on the layout needed — Portrait D or Landscape [_1. If
the calendar has more than 5 terms that are being reported, mark the Additional
space for terms checkbox so adjustments can be made for readability when the
report is printed.

Report Type
» Conventional Report Card

Standards-Based Report Card

Report on Terms
¥ Main - Quarters
® Term 1 Term Q2 '/ Term Q3
Term 24
Exclude all pricr Terms from printing

Page Layout
» Portrait Landscape

Additional space for terms

14. Display Options — Additional information can be chosen to display on the report
card:
a. Header Options — These items, if checked, will print in the header of the
report card
i. Student ID — student number

ii. State ID — state number

iii. Student Counselor —student’s guidance counselor

iv. Homeroom Teacher- Teacher of course or section designated as

homeroom
v. Date/Time Stamp — date and time the report card was generated

Header Options
Student ID

U state
Student Counselor
D Homeroom Teacher

D Date/Time Stamp

Set Up Basic Report Cards © 2017 Custom Computer Specialists, Inc. All Rights Reserved 29
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b. Attendance Summary — Click on the checkbox to print the attendance on
the report card. Choose one of the following options to display the
attendance:

I. Period — attendance by period
ii. Course — attendance by course
iii. Daily Exact Term — exact daily attendance (with decimals)
iv. Daily (Half/Whole Day) Term — attendance by half and whole days

¥ attendance Summary
Period Course
*! Daily Exact Term
Daily (HaliWhele Day) Term

c. Cumulative GPA — Click on the button to print the cumulative GPA on the
report card. The system will display printing options. The GPA can be
displayed as Normal GPA (weighted) or Unweighted. Bonus Points can
be added to the GPA for either option if needed and the system will
include bonus points in the Cumulative GPA calculation.

Cumulative GPA
GPA Calculation: | Cumulative GRA e
GPA Calculation Type: | Weighted GPA |

d. Class Rank and Term GPA — Click on the checkboxes to print the Class
Rank and/or Term GPA on the report card. Bonus Points can be added to
either option. The Term GPA will use the GPA value entered in the Score
Group/List in the GPA Value field (this field is usually the weighted GPA
for AP or Honors classes).

+| Class Rank with Bonus Points

¥ Term GPA with Bonus Points

a. Period — Click on the checkbox to print the period of the courses on the
report card.

b. Score Comments — Click on the checkbox to print the Score Comments on
the report card. Click on the Terms to print — for all terms, click on all
boxes.

¥| Score Comments
Y Term 1 ¥ Term2 ¥ Term 3
¥ Term 4
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c. School Comment (printed on all) - Comments entered here will print on
all report cards.

School Comment (printed on all)
If you have any questions, please feel free to contact you child’s Guidance Counselor.

d. Show Percentage-Shows Percentage in addition to the score value.
15. Mailing Label Options-Report cards can be printed with the following options

a. Student’'s Primary Household Only- Prints report cards for the student's
primary household. Any individual in that household or related to that
household who is marked for mailing on the relationship receives a report
card. Household addresses can be primary or secondary.

b. No Mailing Label- Prints the report card without an address. This can be
used to hand out report cards in class. This should not be marked if the
other mailing label options are marked.

c. Recipient Names- Prints the actual names of the individuals receiving the
report card, instead of “To the parent/guardian of”. Names print in the first
two lines of the address with first and last names.

16. School Comments- will print on all report cards

17. Grading Tasks — Choose the grading task(s) to print on the report card. More than
one can be chosen by using the <CTRL> and/or <SHIFT> keys. All tasks can be
chosen by clicking on the Select all grading tasks checkbox. By choosing Select
all grading tasks, only the grading tasks associated with a course will print on the
report card despite all tasks being checked to display.

Grading Tasks [:] Select all grading tasks

Mid Year Exam ~
Progress Report
Quarter Grade

Semester Average
State Exam

18. Score Group — All the score groups for the district display. If needed, choose the
score group(s) to print on the report card. More than one can be chosen by using
the <CTRL> and/or <SHIFT> keys. The GPA values associated with the scores
can be printed as well by checking the box. Hold the <CTRL> key to deselect a
score group. Note: It is not recommended to select a numeric score group for
display. By selecting a numeric score group the report will attempt to display all
possible numeric values and they will overlap and be illegible.
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Choose Score Groups/Rubrics to be printed

Print GPA values associated with scores

Alpha

Alpha

Alpha Honors

Effort

Effort

Level

Hum BR -

CTRL-click and SHIFT-click for multiple

19. Click on the <Save> button. Repeat for all Report Cards in each school.

Rolling Forward the Report Card to Subsequent Calendars

Report cards are created in the current school calendar year. If the report cards are
needed in the next year, they must be ‘rolled forward’ to each year as it is created.

1. Select the Year and School (on the top toolbar) where the reports are currently
running.

2. Navigate to: System Administration > Preferences > Reports Roll Forward.

3. Select Source Reports — choose the report(s) needed. More than one can be
chosen by using the <CTRL> and/or <SHIFT> keys.

4. Select a Target Calendar — choose the next calendar year (this can only be chosen
after the calendar year has been created).

Select Source Reports
Repo
eneric Report Card Q1
Generic Report Card Q2|
Generic Report Card Q3|
Generic Report Card 04
Level and Performance
Progress Report
Transcript
Schedule
Schedule Terms w/fother
Schedule Days wfother
Schedule With Stuff
eTranscript

Select calendar(g) you would like to roll selected report(s) to:
O fist by =chool
@ list by year

19-20

19-20 Darin Middle School

19-20 Rydell High School
19-20 Westdale Middle School
18-19
18-19 Love Elementary
18-19 Rydell High School
18-19 Westdale Middle School

CTRL-click or SHIFT-click to select multiple

5. Click on the <RUN> button.
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6. The system will display the results. Repeat for all reports in each school.

Reports Roll Results

The following 12 reports have been rolled forward:
Report Name Target Calendar Type
Generic Report Card Q1 19-20 Darin Middle School reportCard
Generic Report Card Q1 19-20 Rydell High School reportCard
Generic Report Card Q1 19-20 Westdale Middle School reportCard
Generic Report Card Q2 19-20 Darin Middle School reportCard
Genernic Report Card Q2 19-20 Rydell High School reportCard
Generic Report Card Q2 19-20 Westdale Middle School reportCard
Generic Report Card Q3 19-20 Darin Middle School reportCard
Generic Report Card Q3 19-20 Rydell High School reportCard
Generic Report Card Q3 19-20 Westdale Middle School reportCard
Generic Report Card Q4 19-20 Darin Middle School reportCard
Generic Report Card Q4 19-20 Rydell High School reportCard
Generic Report Card Q4 19-20 Westdale Middle School reportCard
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GRADE STUDENTS AND GENERATE REPORT CARDS

Description
Prior to running the report cards, the grading tasks must be activated, the teachers must
grade the students, and if necessary, composite grading must be calculated.

Activating the Grading Tasks

In order for the tasks to be active and allow grades to be entered, the Active Mask
checkboxes in the Grading Tasks must be turned on. They are generally turned on by the
Grading Window Wizard (although they can be turned on or off for a specific course
using the Grading Task tab on the Course).

1. Navigate to: Grading & Standards > Grading Window.
2. Select the School Year from the list (i.e., 18-19).

3. Select the Calendar(s) from the list (i.e., 18-19) Darin Middle School). More than
one school can be chosen by using the <CTRL> and/or <SHIFT> keys.

Select School Year
Changing the selected School Year will upd

Select Calendars
CTRL-click and SHIFT-click for multiple

18-19 Darin Middle School

18-19 Love Elementa

18-19 Westdale Middle School

4. Click on the <Next> button.

5. Select the Grading Tasks (or Standards) to be made active (i.e., Quarter Grade,
Final Grade). More than one task can be chosen by using the <CTRL> and/or
<SHIFT> keys.

Select Grading Tasks
CTRL-click and SHIFT-click for multiple

Final Exam

Final Grade

Mid Year Exam
Progress Report
Quarter Grade
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6. Click on the <Next> button.

7. Choose the Term(s) to be made active (i.e., Term 1 for quarter 1, Term 2 for
quarter 2).

Select Terms
Choose the Terms that you want to make active for grading.

NOTE: To turn off grading, leave all checkboxes unchecked.
NOTE: This overwrites ALL current Active Masks for the calendars and tasks you've selected.

¥ Term 1 NOTE: All of these flags default to being unchecked. The display does not
represent the current active mask flags for the calendar(s) and task(s) you've
Term 2 selected.

Term 3
Term 4

8. Click on the <Update Active Masks> button.

All courses will have the Grading Task(s) active for the term chosen.

&< Special Note:

The Active Masks should be turned off when the grading period has been
completed and before the report cards are printed. This will prevent the
teacher from changing the grade after the report cards have been mailed out.

They are turned off by completing all the steps above, but leaving all the
Terms unchecked in step 7.

Turn on Canned Comments (Teacher task)

In order for the teachers to be able to use the comments entered by the administrators,
they (the teachers) must turn them on. This is only done once per year (for each
course/section) and will remain in the teacher’s preferences until turned off. For
additional information on Teacher tasks, refer to the Teacher s Manual.

1. From the App Switcher, select Campus Instruction to navigate to the Teacher side
of the program.

= Instruction \ﬁ Community
App Switcher

2. From the Index, navigate to: Account Settings.
3. Click on the Use Canned Comments checkbox.
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Campus

Frere

Account Settings - Preferences
Select the application you would prefer to load on Campus log in.

Campus Tools |

Select your student display preferences.
[[] Show Active Students Only
Affects display in Student Course R i Course Req , Grad

[[] Show Student Number

e Book, Lockers, Post Grades, Standardized Test, Student Groups

Affects display in Attendance List, Class Serve, Student Course

Show Student Picture

Course Req , Lockers, Post Grades, Roster, Roster Verification, Standardized Test, Student Summary, Student Groups

Affects display in Attendance, Class Serve, Student Course

s ttendance
< [V Use Canned Comments

4. Click on the <Save> button.

Course Reg ;, Grade Book, Lockers, Post Grades, Roster, Roster Verification, Seating Charts, Standardized Test, Student Groups

Manually Entering Grades (Teacher task)
1. From the App Switcher, select Campus Instruction to navigate to the Teacher side

of the program.

01) 0100-1 English for All | 17-18 Darin Middle School

= Instruction & Community

2. From the Index, navigate to

: Post Grades App Switcher

3. Select the term, section, and task (i.e., Q1-Quarter Grade, Q2-Quarter Grade, Q4-

Final Grade) to be entered.

If a task that has NOT been activated is chosen, the

roster will display, but grades cannot be entered.

Scores can be ‘mass-filled

Term Q4 (05/01/16 - 07/31/16) w| Section |1) 3100S1-1 English 9 w| Task |Quarter Grade =] ———

by using the <Fill All> or

ave ercent, Grade, Comment ulti-Post Grades tandard/Grading Task v/ i
s Fill P Grade, C Mutt-Post Grades | Post by [S Grading Task Fill Empty> buttons

Percent is used for t by Standard/Grading Task

Composite Grading
only

Percent Grade

Either click on the

Canned Comment <Add> button to

Report Card Comments

10 Afam, James W :l <0

4. Enter the grade in the Percent field if Composite Grading is used to calculate the

choose a ‘canned’
comment, or type
a comment in the
Comment field

Clear Comments

Final Grade. This will not print on the Report Card.

5. Choose the correct Grade for each student from the list. The grades appearing in
the list are all the grades entered in the Score Group (see page 5). This score will

print on the report card.

Scores can also be mass filled by using the Fill Percent, Grade, Comments

section.

a. Enter a Percent and/or Grade and/or Comment
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b. Select under Students: either the <Fill All> or <Fill Empty> button

Fill: Percent, Grade, Comment
Applies the same value to multiple students

[] Percentage

[ ]

[7] Grade

[+

[[] comment

Students

Canned Comments
Selection Method
Enter Code(s): |

Choose Comment(s):
[] Student has good fashion sense

|

[] 1: Able to leap tall buildings in a single bound.
[] 2: Contributes to all facets of the lesson.

[] 3:Doing well.

[] 4:Excellent student.

[] 5: Favors left side of brain.

[] 6: Greatdebater!

T Uapn a flair far lanauanae

6. Click on the <CC> button to choose comments from the Canned Comments list.
More than one comment may be chosen. The teacher can enter custom comments
in the Comments field in place of (or in addition to) the canned comments. They
can be spell-checked by right-clicking on words underlined in red.

Term | Q2 (10/2218 - 01/1819) [~ | Section [ 01) 0100-1 English for Al

Task |QuarterGrade ]

| +add | | sort | | Fiter |

Save

Grade Totals

Students «

Posted

Fill
Rpt Crd Comments

08 Cohen, Pillayar

08 Edwards, Bailey

08 Hoppey, Brenden J

7. Click on the <Save> button.

Generating Report Cards
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Editing Grades when Grading Window is Closed

Occasionally, administrators will need to edit grades after the grading window is closed.
This is accomplished on the Course/Section, Grading by Task or Grading by Student
tab. The grading window is ‘always open’ here.

1. Navigate to: Scheduling > Courses.

2. Choose the course and section to be edited.

3. Click on the Grading by Task or Grading by Student tab.
4

Choose either the task to be changed (i.e., Quarter Grade, Final Grade), or the
student to be changed.

5. Enter the grade in the Percent field if Composite Grading is used to calculate the
Final Grade. This will not print on the Report Card.

6. Choose the correct Score from the list. This score will print on the report card.
Scores can also be mass filled by using the Fill Scores section.

c. Choose the Score from the dropdown list
d. Click on either the <Fill All> or <Fill Empty> button.

This will not mass fill the amounts in the Percent field.

0100-1 English for All

Teacher: Coach, 01
Section Staff History Roster Attendance Grading By Task Grading By Student
Save

Q1 - Cuarter Grade ¥

Task | Percent ‘ Score | Comments

Q1 - Quarter Grade ¥ v B X

Select items to fill Percent Score Commen its Fill Empty | Fill Al

8. Click on the notepad icon (%’) to choose comments from the Canned Comments
list. More than one comment may be chosen. Custom comments can be entered
in the Comments field in place of (or in addition to) the canned comments. They
can be spell-checked by right-clicking on words underlined in red.

7. Click on the <Save> button.

Calculate Composite Grades for the School

If Composite Grades are used to calculate the Final Grade (or Semester Average), they
may be calculated before printing the report card for that term. The teacher can also
calculate the Final Grade using the Grade Book, if it was set up.

Note: If the Percent field was not completed (see section above), the Composite
Grading will not be calculated correctly.

1. Navigate to: Grading & Standards > Auto Grade.
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Select the Grading Task — choose the Grading Task from the list. Only the
Grading Tasks that have been set up for Composite Grading will display.

Select the Score Group — choose the Score Group from the list.

Existing Grades — click on the Overwrite Existing Grades checkbox if needed.
This will overwrite any grade the teacher entered (or calculated).

Click on the <Auto Grade Students> button to run the program.

Select Grading Task

The Score Group Default - Term Q4 yFinal Grade - Score Group: Numeric ¥
displays in Grading /

Task.

Choose the correct Humeric
Score Group from /

the list.

Select Score Group
Make sure the Min Percentages are set properly for the Score Group you choose.

v

Existing Grades
Overwrite Existing Grades

Auto Grade Students

All students who have a course where the Final Grade task was set up for Composite
Grading will have a Final Grade posted.

Print Report Cards
Report cards can be printed for a batch of students or for an individual student.

Print report cards for a batch of students:

1.
2.

Navigate to: Grading & Standards > Reports > Report Card.

Report Options — choose the report card to print from the list. All the report cards
created for the school will display on the list. Choosing Display Options will
allow the user to create a report card for this one time only. The choices are the
same as creating a report card, (refer to page 29).

Ad Hoc Filter or Grade — choose an Ad Hoc filter or a grade to limit the number
of students’ report cards printing. This is a very complex report so it is suggested
to limit the number of students printing in a batch. However, All Students for the
school can be chosen as well.

Active Only — click on this box to remove the check to choose all students’ cards.

Effective Date — enter the effective date of the report cards. (Option available only
when Active Only check box is selected.)

Sort Options — choose the sort option needed (Alpha, Grade/Alpha, Zip, Teacher).
There are two options to generate the reports:

Generating Report Cards © 2017 Custom Computer Specialists, Inc. All Rights Reserved 39



Custom Computer Specialists Infinite e ot
Right People. Right Results® Camﬁ S

a. Click the <Generate Report> button. The report cards for all students
selected will display in Adobe Acrobat format. They can be saved or
printed, but not edited.

b. Click the <Submit to Batch> button. This option generates the batch
report in the background while the user is free to use other parts of the
product. The Batch Queue Reporting Options window will display.

i. High Priority — the report will be placed at the top of the queue
ii. Keep Until | Delete — the report will remain in the queue and
ignore system expiration preferences

iii. Start Date/Time — when the report will be generated

iv. OK —click to send the report to the Batch Queue
The report can be accessed later from the Batch Queue List when the Get
Report link appears in the Download column. A reminder will also appear
in the user’s Process Alerts.

Report Card Batch Report

This report batch prints student report cards, one page per student, suitable for handing cut. This is a very complex report; try
to limit the number of students selected per batch.

Report Options

OR
Dizplay Options

Ad Hoc Fitter
oR

o

Grade All Students -

Active Qnly

Effective Date 121212018 T8

Sort Options ® apha O Gradeiaipha O Zip O Teacher

Batch Queue Options

Refresh | Show top tasks submitted between [12/14/2018 |75 and[ 1212172018 |75
Batch Queue List

Queued Time | Report Title | Status | Download

The report cards for all students selected will display in Adobe Acrobat format. They can
be saved or printed, but not edited.
Print report cards for a single student:

1. Navigate to: Student Information > General. Select the student.
2. Click on the Grades Tab.
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3. Choose a Report Card Format... — choose a report card from the list. All the
report cards created for the school will display on the list.

Infinite ;{ " .

Campus

The report card for the individual student will display in Adobe Acrobat format. It can be
saved or printed, but not edited.

Darin Middle School
Any Road
Any City, NY 11790

Sample 2" Term Report Card

Abbate, James

2018 - 2019 Report Card

Grade: 08
(955)123-1234
GPA Summary:
Term GPA Qi Q2
Unweighted B8.917 940
Attendance Summary:
Qi Q2 Total
Absent Tardy Absent Tardy Absent Tardy

2 0 O 0 2 [1]
Grade REPOI’t:
Course Task a a2
O7100-14 English Tor All JAbbate. Sharon] Cluarter Grade BT
0200-5 Social Studies [Coach, 13 Cluarier Grade T
0300-1 Science Scenarios [Barbien, J] Cluarter Grade [51]
0400-2 Math Moments [Rhrens,] Cluarter Grade BT
2000-T Media Arts T [Abart, Manon] Final Grade o0

Cluarier Grade o 41
Tem 2 Comments:Contribites to all f3cafs of the lesson. Excalent siagent.

hooo—= Life Adustment [Ahrens, Cluarter Grade o
B089-10 Physical Education [Conmoliy, ] Quarter Grade a4

Generating Report Cards
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GRADING REPORTS

Running Reports

The reports available in the Grading and Standards module provide details on a student's
progress in courses, transcript information, standards progress and cumulative labels, in
addition to containing reports administrators can use to see how active teachers and
counselors are in updating student grade information.

Class Rank Report: The Class Rank report calculates a student’s class rank that is based
on historical (transcript) grades.

Course Credit Report: The Course Credit report lists the credits associated with each
course.

Cumulative Labels Report: A Cumulative Label is a large-size mailing label that has an
entire year’s transcript printed on it.

Grade Book Usage Report: The report will track how well teachers are maintaining their
grade books.

Grades Report: The Grades Report will print the students’ grades based on the criteria
chosen. This report is useful in determining which teachers have not posted grades or
which students have missing grades.

Grading Setup Audit: The Grading Setup Audit Report tracks the setup of teacher grade
books and displays grading tasks, standards, categories and grade calculation options for
the selected courses. Select one or all teachers and one or all courses, as well as the data
to report.

Missing Assignments Report: This Missing Assignments report allows users to view
assignments that have been flagged in the Grade Book as Missing, Incomplete, Late, or
Exempt.

Standards Alignment Report: This report will list the assessments associated with each
standard.

Students Credit Report: The Student Credits Report displays the total number of credits
earned by the students in the selected calendar.

Term GPA Report: The Term GPA Report displays each student’s term GPA for the
selected term.

Transcript Audit Report: The Transcript Audit report will compare the transcript data
with the source grading data and will list the differences in score and comments.

Transcript Batch Report: The Transcript Batch Report pulls student grades from their
transcript and typically places them on a one-page document.

eTranscript Batch Report: This tool will create a batch of electronic transcripts for
upload to third party vendors of choice. An eTranscript for this batch tool should be
designed in System Admin > Preferences > Reports and selected from the Report Options
list.
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